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1. Rockchip DSP &4

DSP HI# 75 5 b #E R . DSP /ENEIFE S B SGRIE S5 Y, HTTRHAEEN S
HSEh AR, EEAEE, Ry, WE, RIDEMFImIhEE, EEREEGAAHE, EEOE, F5408
SIS A BRI E B /EH . @ N Cadence® Tensilica® HiFi3 DSP & /1

o HiFi3 DSP & —F ISA, 3(HF 2-way SIMD 42 .
o HiFi3 DSP 7 £ I AbBE A 32x32 BY 24x32 bit FHE, 4 1 24x24. 16x32 B 16x16 bit Fiif .
o HiFi3 DSP 3 ¥ [ AL BEPE A IEEE-754 ¥ s 040

HHl, Rockchip SoC FER®) DSP BB 41T

» RK2108. RK2206 1 PISCES£E A% HIFI3 DSP.

2. HIFI3 341853 2

2.1 Xplorer T H %23

2.1.1 Windows3f &

HiFi3JF & LB 4Fr N“Xtensa Xplorer 8.0.8”, License 77 4Bt & Cadence 3KHL. FRATTMAT A 0 L H e
{1 4 Xplorer-8.0.8-windows-installer.exe*, Ft & fl N*“HiFi3Dev181203 win32.tgz”, FtE 3T RG-2018.9
(LAt T EL 22385 40 “XtensaTools RG 2018 9 win32.tgz”. #5523 Ml B4 IF & A G 3RHEL

6% 35 Xplorer-8.0.8-windows-installer.exe, %M $E R RI 0] 58 Al 22 %5 .

ETENE, TR T AM, 1E Xplorer 1, “File” --> "New” --> "Xtensa Configuration”, X% T K1
Fic & DU 57 Install BRI, 485 25 diNext:

Create a Xtensa Configuration ]

Select how the new configuration will be created

() Create new configuration with a new core ISA (requires XPG access)
() Create new configuration by importing from file.

() Create new configuration based on an already installed build

®) Install a new build from downloaded bundle as the new configuration

/O Install a new build from XPG as the new configuration (requires XPG access)
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¢ s diManege Xtensa Tools, £ 1) % [ 25 diInstall from Distribution, 1%+
XtensaTools RG 2018 9 win32.tgz T. L ELIR4E, 1eidn2eds.

MNew Xtensa Configuration O >
Install Xtensa Build —
Add Xtensa Processor Builds to Your Workspace [
Download Build from the Xtensa Processor Generator
¥PG release: FindProcessars
Locate Previously Downloaded Build
Browse...
Add Build
Xtensa Tools Manager
Manage Xtensa Toals h__&
Add Processor Builds to Workspace
Available Builds Builds in Warkspace
Add to Workspace Revert add
Create default Xtensa C project (hello world)
] Add command shell to Start menu
@ = Back MNext = Finish Cancel




¥tensa Tools Manager

¥tensa Tools versions - installed, and available

Installed |RG3-2018.0
Versions |RI-2018.0

State of selected version

Location |

|
Valid? |

Locate installed Xtensa Tools ... | | Install from Distribution ... | Download from XPG ...

Purge deleted tools

Close

ZH S T RS, REFESE, SdiBrowsei£#HiFi3Dev181203_win32.tgzfiL &, i fid7Add Build
M EA, £ F RO ERHN R4S, sdiFinishie 3.



New Xtensa Configuration O x
Install Xtensa Build —
Add Xtensa Processor Builds to Your Workspace |
Download Build from the Xtensa Processor Generator
PG release: FindProcessars
Locate Previously Downloaded Build
I HiFi3Dev181203_win32.gz | Browse..
Add Build
X¥tensa Tools Manager /
Manage Xtensa Toaols
Add Processor Builds to Workspace
Available Builds Builds in Warkspace
HiFi3Dev181203 HiFi3Dev181203
Add to Workspace Revert add
Create default Xtensa C project (hello world)
[+] Add command shell to Start menu
@ = Back MNext = Cancel

PR ARG, &7 T AFEF"C:(Active configuration)”, &7k H I NHAE, AIfERBHEER

HiFi3Dev181203, sididfikr:

ools Window Help

-

C: HiFi3Dev181203

-

-

T: Drebug

Build Active -

X B 22 R f ) System Overview it 2> & £IF1 9% HiFi3Dev181304 [FEL B SC/F, sk, &F
FI4 [T Core ML EEE. A LLE RN RfH ITCM. DTCM. HHr 55, %848 INTC [kl

INterruptO.

=

& Systern Overview I3 ]

& |1

v [z Configurations

Workspace Config

Caonfig in XPG

v (= HiFi3Dev181203 (RG-2018.| | | Configuration

@ HiFi3Dev181203
[ HiFi3Dev190311NoWind (R
(= hifi3_bd5 (RI-2018.0) (D:\ar
= hifi4_bd7_vfpu (RI-2018.0) |

HiFi3Dev181203 [LX7]

Dec 3, 2018 2:37:28 PM

hifi3_bds

Edit | View Details

rockchips_sw/sw

0 &

(== hifi_mini (RI1-2018.0) (D:\anz
TIE
[z sample_controller (RI-2018
= sample_flix (RI-2018.0) (D
= tie_devl (RI-2018.0) (D\an:
B Build

[z tie_dev2 (RI-2018.0) (D\an;
[z XRC_FusionF1_All_cache (Rl
[ Uninstalled Configs

>
>
>
>
» 2= sample_config (RI-2018.0)
>
>
>
>
>

!

COMPLETED




2.1.2 Ubuntu¥f &

T & T ETEUbuntudf 5 A AR EULE L (A SR04 A 1)@, B AERATTEE BUR & 7E windows T K

Ubuntu 64bit fRAS R G0, FATHER ) T H 223540, A “Xplorer-8.0.8-linux-x64-installer.bin”, %15 /& Ubuntu
32bit ARG, HEFE TR %A “Xplorer-7.0.9-linux-installer”. Ft & 4“HiFi3Dev181203_linux.tgz” Al
“XtensaTools RG 2018 9 linux.tgz”. Z3%idFEFMWindows—%{.

AL B AL oN32bit, AT AR S, FTEHATLL T4

sudo apt-get install 1libgtk2.0-0:1386 gtk2-engines:i386 1libc6:1386 libcanberra-
gtk3-0:1386 libxtst6:1386 libncurses5:1386

sudo dpkg --add-architecture 1386

sudo apt-get update

sudo apt-get install 1ibc6:1386 libstdc++6:1386
sudo apt-get update -y

sudo apt-get update kernel* -y

sudo apt-get update kernel-headers kernel-devel -y
sudo apt-get install kernel-headers kernel-devel -y
sudo apt-get install compat-libstdc++-33.1686 -y
sudo apt-get install libstdc++.1686 -y

sudo apt-get install gtk2.i686 -y

sudo apt-get install libcanberra-gtk2.i686 -y

sudo apt-get install PackageKit-gtk3-module.i686 -y
sudo apt-get install 1ibXtst.i686 -y

sudo apt-get install ncurses-1libs.i686 -y

sudo apt-get install redhat-1sb.i686 -y

2.2 License &3t

FTIF Xplorer T. 5, T “Help” -- “Xplorer License Keys” , 7 “Install License Keys”, i\ C/E#%
%o SEAJE, Al “License Options” B "Check Xtensa Tools Keys” il License IR&. 7 ZivE Bmaciihl:
B M liscense ™ ffThost id—

X

Install Xplorer and Xtensa Tools License Keys

You may browse to a license file, copy it to a standard location and point to it,
point to the selected license file in its current location, or point to a floating license server.

Browse to the License File / Type License Server Address of form <port=@ =server=

|CﬂUsem\hp\Ienﬂ“caUkenseﬁc Browse...

Choose where to install the license file
(®) Copy the selected license file to standard location: C\Users\lhp\.tensilica\license.lic and point to it

() Point to the selected license file in its current location

CE) Finish Cance
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23 TIESALHE

231 TESA

TR H SRR H I Projects &, ##A2 Ahifi3/kdsp/projects, A7 AN R T2 1 o B SC AT T AR S

jEid File” --> “Import” --> “Genaral” --> “Existing Projects into Workspace”, 5 iiBrowse, % #lprojects
Ha, #HRESATREAN, ARIHXRA R TREAP, IRK2108 X T4 2 RK2108 ,
RK2206 %} i T. #2442 RK2206.

FALRE, AT HAF“No Active Projecthn®shl, sidifaflfisk, FHok#E HAs T, WP:RK2108.
2.3.2 % P10 T i B

7E T A Ak 9% % (f) Target, 4> A Debug. Release 1 ReleaseSize. A~[A|Target¥t & | ASE AL,
RISE AR AL, EARIIT A P8 28 0T LLE N Targetf& i A BB AL, BORR 9 75 22 F AT R
Target. 5HCE Al 255 AT Debug A Ml F $i dir Skt A7 P) 4 . s AP i Modify 7] BLiE N\ Targeti& 2 5t
i

Target!& BSUF T FI R4 «

Symbols: #INZEE Lo

Optimization: 12 24 BEiL I

Linker: EFEMAPH R, BIEERMAH 5.
Libraries: &3 CIF#E1E .

Addl Linker: S INHESE B 84 Bk .

FEAIAEE 1R 77 ALl Optionsffi A\ g 3 E e 75 5 T — 2.
2.3.3 fmiE

His LFE. LB, TargetfliFEE, Mt T AR “Build Active”BI A IEH B T401%, mIR4E RAZL
TELFEHEFM bin BXF.

2.4 DSP [ 44 ik

TRAMKHPAT A AR T TR R, AREEBA RS L. 1817 CMD #=Hl &, REIE R4 A
generate_dsp_fw.bat U, HEABRZISCAFE H FPATIZIA, AR5 0T

generate dsp fw.bat <project name> [config file]
Hr<project name>NWIEI, HTfw THE%, WRK2108
[config file]l AWET, M T e BAECE XM, WrwConfig.xml (AHEENERINNFwConfig. xml)

VR A HITER B € S AR, TETIA 2R Xplorer 1 Project & 75 IEAfIEFE,
generate_dsp_fw.batl& T T2 H 5% T Makefile 3 2 &4k T. R #%4%. Target. Configuration5s, WIER HTiL+F
M TAEANIER, XS R f Makefile N2 i, - IEHAE e Makefile il B BT -
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.a .0 .c .cc .C .cpp .s .S .h

SHELL = cmd

PATH =|C:\Programs\Xtensa\XtDevTools\install\tools\RG-2018.9-win32\XtensaTools\bin\;C:\Programs\Xtensa\XtDevTools\install\tools\RG-2018.9-win32\|
XtensaTools\11b\iss\;C:\Windows\system32

:\\MCU\\hifi3\\rkdsp\\projects\\RK2108\\bin\\HiFi3Dev 203\\Debug 56 $(MAKE) all "

" XAMCUN\hifi3\\rkdsp\\projects\\RK2108\\bin\\HiFi3Dev 203\\Debug §6 $(MAKE) clean "

% Ki FBmode:Off v P:RK2108 ~ C:HiFi3Devi81203 ~ T:Debug v E

generate_dsp_fw.bat JHIA 22K 5t W TH2 H 3% 1 FwConfig.xml « Bin2Array.xml. [E£FZE# 112 tool H 3%
~, A H HifiFirmwareGenerator.exe FJ L& 4, & E AT
tools/HifiFirmwareGenerator/output/rkdsp.bin. HifiFirmwareGenerator.exe RS A7 T

/components/hifi3/rkdsp/tools/source code/HifiFirmwareGenerator

[E] i LA 2 B4 T F2 7 “Firmware ArrayGenerator.exe” R # Bin2 Array. xmlfit & ¥ rkdsp.bin% it JyAH M i C 4.
. FirmwareArrayGenerator.exe FJJRASAE T

/components/hifi3/rkdsp/tools/source code/FirmwareArrayGenerator

AN ST I T5 il 2753 27 B -

2.5 [E 1T R Be B 3XAF

HEHNTHEERT, HH—4 FwConfig.xml 3, %A RA Xml & L —LLEAFRE. HisqT
HifiFirmwareGenerator.exe I, #4857 H ¥ FwConfig.xml, 1X B H 1A CEE B X

o CoreName: %% Core 4 HK, A ZARIEMakefile [ 21 #t tag corename FE:, HFEAGH
CIESAIE S

o ToolsPath: %% Xplorer 1 T H H 3, A SR Makefile H 3 & # tag_toolspath 7B,
RN G WA F B E K.

o ExecutableFile: #1444 .

o SourceCodeMemStart: DSP i ACH Py 47 25 0] f S s Hoduk-

e SourceCodeMemEnd: DSP i CH Py A7 25 [8] ) 45 s bk

¢ DestinationCodeMemStart: MCU i % 57 ¥ AR P 77 2% 8] B ke, BRI AT BEAFAE P A7 25 8] B S5 A
R bean [l — S BN A2 ik TCM, DSP (1955 [ iy ik /2 0x30000000, MCU 5 1] (1 ik 2
0x20400000, ‘B> HI%T N SourceCodeMemStart il DetinationCodeMemStart. 415 bk S AR ],
MAIEAFT BRI AT,

o Image: fHH[FEfF. T SCRFTH7 7 DSPEA:

o Image/Name: [E#F4%, FIULX SR, MAINN T BE 4, AR 44 Arkdsp.bin, A R [
PEp % Sectionsk /5 8. Gk, K/NSE) , FT-CPUEMT INELDSPREIMFE H ; EXTRAME 1
A2 Bl A 44 gext_rkdsp.bin, JoSectionZkfE 5, #%Sectiontihib il FHEF, Al B 4T €L 2= CPULE £,
bek EFlashiit € L&, DSPIZATI EEELHOM M¥HE, TCFHCPUMNEL.

o Image/AddrRange: 57E & T %[ {1 Sectiontti bk il .  PAXIP MY, Huhbyo Ry
0x60000000~0x60800000, 1% [ A fISection 4T W 452 M (—BONEXTREMMF) o 7 EA
ANER, EREAETER, S ETE R BT 2 Section g, 1% FwConfig.xmlH Image 1) HEF1
N 73 ARG B, i — ARG B AR % Image 1T Bl Y, JUFT 60 2 Image M Section 4 k. Wik
Yl Image AR 5 7E AddrRange, BRI 247l Section 4 H Il Section #1142 Y i Image, [FItA T4
€ AddrRangefImage— & B 5 7F K 45 7€ AddrRange ] Image” All, 1T :
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<Image>
<Id>2056</Id>
<Name>EXT</Name>
<Type>Permanent</Type>
<AddrRange>0x60000000:0x60800000</AddrRange>
</Image>
<Image>
<Id>2046</Id>
<Name>MAIN</Name>
<Type>Permanent</Type>
</Image>

HFMAINS FEXTZ R, FTHMAINK, SectionZ4 N T4 Section#f T L EMAIN, NFTWEXTH, &
JoH M Section. BAEMAINA S IIAddrRange 7 BRI, AT PUGARAEFF Y . AddrRange ] 73 Bt 22 IR
feE, WK

<Image>
<Id>2056</Id>
<Name>EXT</Name>
<Type>Permanent</Type>
<AddrRange>0x60000000:0x60800000</AddrRange>
</Image>
<Image>
<Id>2046</Id>
<Name>MAIN</Name>
<Type>Permanent</Type>
<AddrRange>0x30000000:0x30010000</AddrRange>
<AddrRange>0x30200000:0x30280000</AddrRange>

</Image>

2.6 [E e B e B

75 T2 H 3% N AFAEBin2 Array.xmISCHF, AR @ et . SOPF b 3 B W an T

o Type: AERUICHIZAZEN,
Name: 4B CEUA A4 FR
o Input: fRFEHe1).binS .
Output: 4 H S

2.7 Map BLEE BB

Xplorer TEEHZIT B 75 ZEAR T Map I B (5 BT &M B = [0 40 C . 78 " Ti(active build target) ” --> 7
Modify”, 1+ Linker. 7] LUF 3| Standard 1501, W] LULEFEERINK Map FLE, Xplorer N K& Heft 1
min-rt. sim ZECE, XL E SO H A7 R < T2 2225 H 36>\explor8\XtDevTools\install\builds\R G-
2018.9-win32\HiFi3Dev181203\xtensa-elf\lib” H 5 F . FC B AH R AF Bl LA SO« <TH %236 H s>
\XtDevTools\downloads\RI-2018.0\docs\Isp_rm.pdf”.
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2.7.1 & 2 BC B SO

BB SN memmap . xmm ;- PAmap\min-rt\memmap xmm AF], HA 5 E T sram. iram0. dram0— /MBS
[, FHHiram0Mdram0J& T DSPITCMWNAE, Vil EE R, sramf& T RGN AF, DSPRI LA, {Hif

B TCME . sramMlliram0f@ 4 NP 525 . ATHAT, dramOE NS . B, 8% 7Eiram0H il B AT
B, fEdramOH B A B, {Eiram0Edram0ZF [ AS B, 1] DL Rk AR AD B B s Bl 2 sram.

ARG BIS E sram A AT, —MONEREETIN L attribute
((section((".sram.text")))) o H—MEEHBINEL Esram, LEBIAE B Estam ], 1E
IR

@@ -51,7 +51,7 Q@
BEGIN sram
0x20000000: sysram : sram : 0x100000 : executable, writable ;

- sram0 : C : 0x200C0000 - O0x200fffff : .sram.rodata .sram.literal .sram.text
.sram.data .sram.bss;
+ sram0 : C : 0x200C0000 - 0Ox200fffff : .sram.rodata .sram.literal .sram.text

.literal .text .sram.data .sram.bss;

END sram

BEGIN iramO
@@ -61,7 +61,7 @@ BEGIN iramO

iram0 2 : F : 0x3000057c - 0x3000059 : .DebugExceptionVector.text
.KernelExceptionVector.literal;

iram0 3 : F : 0x3000059c - 0x300005bb : .KernelExceptionVector.text
.UserExceptionVector.literal;

iram0 4 : F : 0x300005bc - 0x300005db : .UserExceptionVector.text
.DoubleExceptionVector.literal;
- iram0 5 : F : 0x300005dc - 0x3000ffff : .DoubleExceptionVector.text
.iramO0.literal .literal .iramO.text .text;
+ iram0 5 : F : 0x300005dc - 0x3000ffff : .DoubleExceptionVector.text
.iram0O.literal .iram0O.text;

END iramO

e Ja f Bt Amap H 3T, (8] T EARSE 2 HC B SO H0T E B A

cd rkdsp\projects\RK2108\map
<install path>\XtDevTools\install\tools\RG-2018.9-win32\XtensaTools\bin\xt-

genldscripts.exe -b <map directory> --xtensa-core=HiFi3Dev181203

Hrh <install path> N LHEZHEHZF, W Cc:\usr\XtDevTools\..., <map directory>ﬂ~jﬁﬁ<map
AP, Ul min-rt o

DA A I 3R
New linker scripts generated in min-rt/ldscripts

HERCRMG, SATEVAHRIE R, TR EHR PR BT % .

HE: HTstamNRGNAE, A HBlsram, WF S5CPUMRH KA G sram=S (8] 40, 8 5 BT
[R5 1) /] — R A S B 4%, A17E sramO AP 8 %2 AL IR 31k 90x200C0000,  WiZ k43 /i i) 25 (8] A CPU RS
H, &b AR 5 02 8 9DSPA] . CPUNR 75 B EATAH R % &
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2.7.2 B EE B A

& memmap xmm3CAFA)JT 3 R BEABON ALEEAT B, RO, AR SR E 25—
Bl i ok, AT DL E RS O R A S B -

--— a/rkdsp/projects/RK2108/map/min-rt/ldscripts/elf32xtensa.x
+++ b/rkdsp/projects/RK2108/map/min-rt/ldscripts/elf32xtensa.x
@@ -211,6 +211,8 @@ SECTIONS
{
_iram0_ text start = ABSOLUTE(.);

*(.iram0.literal .iram.literal .iram.text.literal .iramO.text .iram.text)

+ *filel.o(.literal .literal.* .text .text.*)

+ *file2.c.o(.literal .literal.* .text .text.¥*)

+ *libx.a:*.o(.literal .literal.* .text .text.*)
. = ALIGN (4);

_iram0_text end = ABSOLUTE(.);

} >iram0 5 seg :iram0 5 phdr

VER: A of.coMifiEil, —MIEN T, .coNHXplorerdmBFraE, .o NFRHEFEN T, BEfkZlo
Eﬁxxoﬁgfj, ETELEi%%Ei%%Jnap)tﬂ#ﬁ%iko *libx.a:*.o(.literal .literal.* .text .text.¥*) m”
S PE N A .of8 € BZBL. T AMITIZ L B i fr 2 BT AR B R IA, K B R T B
B R FahiE ek, $AT B 3 L R T 6

&4 5 il J5 7E Xplorer ) Target-> Linker 48 map Hx, BHH BRI, w15 i% + “Generate linker map
file”, WAMSAEmBETERIG AR map XM, HLHENCSR T4 HIEE A, DURUE BB A4
o

3. RT-THREAD fXHG @ Hr

3.1 AR fE

DSP HEZL:

bsp/rockchip/common/drivers/dsp.c

bsp/rockchip/common/drivers/dsp.h
DSP WA Ae =«

bsp/rockchip/common/drivers/drv_dsp.c

bsp/rockchip/common/drivers/drv_dsp.h
DSP 3XZf i FH RS AT AZ25 DL i A 41 -

bsp/rockchip/common/tests/dsp test.c
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3208

FTF DSP driver FC BT, i PARK2108 LAE RNHI:

RT-Thread bsp drivers --->
RT-Thread rockchip rk2108 drivers --->
Enable DSP --->

[*] Enable DSP
[*] Enable firmware loader to dsp
Dsp firmware path (Store firmware data in file) ———>
(/rkdsp.bin) Dsp firmware path
[ 1] Enable dsp send trace to cm4

(-1) Config dsp debug uart port

”Enable firmware loader to dsp“Z 7~ DSP IR0 5 BN 1IH%, 2 %K DSP [l 44;
“Dsp firmware path” A AN IE A LT P AN G T :

o — ML Store firmware data in file*, [ #F# F flash ™ ffirkdsp.bin, [E {4 ikE7E“Dsp firmware
path”H455€ . “/rkdsp.bin” 7] A& U REEHIER AT, AT L — AN AU (FEsetting.ini I
dsp[E£F4r XD .

o J3— /TR “Store firmware data in builtin ”, /=¥ DSP 152 A B md [ 2F 4, G 198 1 I 25
A2 Hskdsp fw H 3% N frkdsp_fw.c | 4%, rkdsp fw.cZ%2.517 DSP [H{F A4 1 b 48 4 A e
N TREBRINCREXIP, DSPRE 2t g e BIXTIPH . FHIXFh 7 I AL 2 T B 07 (8, AN/ 8 S0
RGHRIE . HRRELASFFXIPHINARM ], S NDSPREFSBIMEEIMAR AT, IRENAFT
578

“Enable dsp send trace to cm4” &/~ RE trace VJRE, 14387 DSP H4TEN log W LAYE ARM HTEN
K, IBAFTED log BEAS Ta BT B )

“Config dsp debug uart port”F R~ 15 B DSPF] ENAT UART ¥ 1o S0 RAE -1 LKA SR E . DSPAIE Bk
NV UARTO.

3.3 X3 A A

IR A 77 AT BL 22 “bsp/rockchip-common/tests/dsp_test.c”.

struct rt device *dsp dev = rt device find("dsp0");

rt device open(dsp dev, RT DEVICE OFLAG RDWR) ;
rt_device_control(dsp_dev, RKDSP CTL QUEUE WORK, work);
rt device control (dsp dev, RKDSP CTL DEQUEUE WORK, work);

rt device close(dsp dev);

WA rt_device open B[, 2 FHEIIKBNHI“rk_dsp_open” i %, 2347 )53 DSPcore LA K Nk [l £, I
H¥s DSP RILiz TR

A “rt_device control(dsp_dev, RKDSP CTL _QUEUE_WORK, work)” Il 1%, £ XN work 841, Rzh<iE
i mailbox ¥ work &Ki%%5 DSP, DSP fif##ft work, JFFuEATHHRIAEIEERIE, 4 work ALEREE ALk,
Fi“rt_device control(dsp_dev, RKDSP_CTL DEQUEUE WORK, work)” "] LLHX[A] DSP [ 572 4b F 4%

NSk DSP B7EALEE b, TR A ZR xR ZE, E 2 DSP AL S8R
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3.4 i case

$TFF DSP TEST #1 AUDIO TEST e BT :

RT-Thread bsp test case --->
RT-Thread Common Test case --->
[*] Enable BSP Common TEST
[=1 Enable BSP Common AUDIO TEST
[=]] Enable BSP Common DSP TEST
[*] Enable Dsp wakeup function

ik ek fa, RSl Adsp vad test, B LA EUl Flog:

msh />dsp vad test

dsp wakeup test

Hmsh />ifi3: Hifi3 config done

Hifi3: kwsSetConfig ok

Hifi3: init uv_asr ok

ringbuf addr:0x30260000, period size:0x00000280

i Naudio_capture5, XHEFEW, “xiaoduxiaodu®, B LRI E] MR :

msh />audio capture

audio capture

vad buf: 0x30260000, size: 0x20000 bytes

vad periodsize: 0x280 kbytes

msh />Hifi3: xiaodu wakeup-------- xiaoduxiaodu-------
Hifi3: process return value = 1

work result:0x00000001

3.5 Vendor Key % %%,

PAflash wuid 951, 98 IR FE ARG T -

1. f# FFlashKeyTool 5t HY flash uuid

2. _E—245 3] Fiflash uuid TH 5 H R 56 B 48 () key

3. {#i FHFlashKeyTool L B ¥key 5 A Flflashf\)vendor 7 [X.

4. CPUMIEF Mvendor 7y [X i Htkey, &Ki%ZDSP

5. DSP i flash uuid, £ H T JEFCPU K% Mkey#EAT EL Xt
6. DSPHs bxH 45 SR 3% Bl CPU

7. CPUAMDSPHR Y 16 25 RARUAH W Ak 2

e BRI~ RRRINP R, WA A SRS E ) TR, AR — A TR N e -t Rk A .
CPU

T ACRE B 42 bsp/rockchip/common/tests/dsp_test.co

P & N HR A7 42 dsp_vendor_test, BIRIFFAAMINA, I 75 DSPLE 4 A I J8 B30 S FF

DSP3i

ARHD % 45 Arkdsp/application/RK2108/key verify.cpp.
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Y i 7 7E Target N %€ 3L DSP_VENDOR VERIFY = 1, JFRRIRSIEE OXtESE
rkdsp/application/RK2108/key_verify.cpp 3 1 ffisnor_key verify i, %30k & NA\CPUK % Mkey, IF
FEA B0 R B3R BB 3R [7] 45 CPU

4. RKOS AL f#dr

4.1 fRAG B

DSP K52

src/driver/dsp/DspDevice.c

include/driver/DspDevice.h
DSP Jx B} FH R AT A2 2% DL A A 51«

src/subsys/shell/Shell DspDevice.c

42 ic &

FT7F DSP Driver BTt 21T -

BSP Driver --->
Enable DSP --->
[*] Enable DSP
[*] Enable firmware loader to dsp
Dsp firmware path (Store firmware data in file) --->
(/rkdsp.bin) Dsp firmware path
[ ] Enable dsp send trace to cm4
(-1) Config dsp debug uart port
[ 1] Enable dsp jtag

menuconfigiZt I3 2L AR —F, X B i F AR 7 -

1. tkdsp_fw.hA7 i H 3% MCN T "sre/driver/dsp/dsp_fw".
2. ¥iNJI'T “Enable dsp jtag”i& i, FKxffEEDSP JTAG.

4.3 I3

IR H 7 AT BAZ 2 “sre/subsys/shell/Shell DspDevice.c”.
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rkdev create (DEV_CLASS DSP, 0, NULL);

HDC dsp dev = rkdev open (DEV_CLASS DSP, 0, NOT CARE);
rk dsp open(dsp dev, 0);

rk dsp_control (dsp_dev, RKDSP CTL QUEUE WORK, work);
rk dsp control (dsp dev, RKDSP CTL DEQUEUE WORK, work);
rk dsp close (dsp dev);

rkdev _close (dsp_dev) ;

rkdev_delete (DEV_CLASS DSP, 0, NULL);

VAR LS 3 3 RN A, RERBEZE AR, #4757 202 1.
4.4 Mk case

$TIT DSP Testfit B0 T -

Components Config --->
Command shell --->
[*] Enable DSP shell command

Gkl fhber)E, EIEH G % Adsp_test, ATLAE U FLOG:

dsp test

Hifi3: Hifi3 config done

Hifi3: kwsSetConfig ok

Hifi3: init uv_asr ok

config end

[A.DspTe] [000024.61]workresult:0x00000000
[A.DspTe] [000024.61]work result:0x00000000
[A.DspTe] [000024.61]work result:0x00000000

5. HisERE LA

5.1 TIEGIE

1 File->New->Xtensa C/C++ Project, L3 T RIS HEN LM RE S . Locationth 5t /2 LFE H
3, AJULHBRAR, HArblE g, fidiFinish/5, 7E“Project Explorer”# B Hn] LLA B H & 10 T2

“libasr”.
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=]

e

Mawy ¥Eam CiC
lew Xtensa CfC++

Create a Xtensa C/C++ Project

Project NV

||ibasr

Import Source For Project

| Browse...
Only import source files
Project Type i
() Create an executable imV
(®) Create a static library
() Create a shared data library (for MP subsystems)
Use default location /
Location: | D:\cadence\workspace\libasr Browse...

@

Cancel |

AH SR S SO SO T LB BB TREH R, af iAo T2,  fidiFile->Import->General->File
System, 7EBrowseHiEHUAS B H %, fElnto folderit % S N MIALE . “Create links in workspace”#
ARG, SRS ASE IR THEERTN, XA E4E RS, KA AN TR

AR IS



File system —
€3 Source directory is not valid or has not been specified. . B

% /

From directory: w Browse...
Filter Types... Select All Deselect All

Into folder: ||ibasr Browse...
Options

Owverwrite existing resources without warning

Create top-level folder

== Advanced /

[ Create links in workspace

Create virtual folders

Create link locations relative to: | PROJECT _LOC

® = Back MNext = Finish Cancel

5.2 FE SCHAE R

SHE Y e ], W PRI AT, BAS, W] A(diBuild Active T 4R% 6. mikei)a, KAE
project/bin/HiFi3Dev181203//H 4 ifilibasr.a X4 . Target$i A& 2 e 0 10 W] 32 2 IDebug. Release-
ReleaseSizeds . F2 T KA SCAF AN 1 Sk STHF 3T 2 H Slibasr, 45 5N TR .

5.3 HILEFA

H4 A U libasr.a i \hifi3/rkdsp/library/libasr, #& 518 id s i File->Import->File System ‘& A\ T.f##. A5
ATargetlE A, TEAdA] linkerbrZE TR IR I“-lasr”.  7ELibrarystrs 71 - 8N 45
“§{xt_project_loc}\..\..\library\libasr”. 7 Linkerfs%s U1 ! [1F)iE 5 3&E I map .

B FoRAHTHIOIERS, — & TElibasr SCAF R I — A& AL S libasr.cppllibast.h, JESNTHE, Bk
P52 TR R . SR )5 fEalgorithm handler.cppis A £ 11 .
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5.4 5 DL IR R

1 AN B SO

ffiiALibraryshns 5O RS2 TS IEHA,  libxxx.aSXCHF A2 7 fim 44 IEFf (LA libxxx.affy 2, HoAE] )
xxxX NES, ISINVEEREF F-xxx), HSEERMERE, I+ H SN TRRI.

2. AN BN R HUE X

5 E1—FE, HEEESANET LM B a NFhCErh, BOREE AR SEFEH
extern “C”FH, AW F:

#ifndef  LIBXXX H
#define  LIBXXX H

#ifdef  cplusplus
extern "C" {

fendif

int libxxx init(int arg);

int libxxx deinit (int arg);
#ifdef  cplusplus
}

fendif

#endif // _ LIBXXX H_

S0k B2 1 SR itlibasr.cppedd Jylibasr.c FE 5745 P

6. XIPHE R,

ETCMAISRAMES A G548 A5 LR, SUEFF textFl.rodataph§ BU ZE Flash™, 75 ECPUNK T B XIP £,
Al E AT I RN B o TE Flash (R ACHS FIEC PG e B0, 2 Eu s I B A S MU T 850, DRI B pR 5
FIEHE B AR S IE TCMAISRAM A &

6.1 FRE

XIPRL T 75 ZAE F calloy Bk #%, H RIS M K8 HiF13Prod200605 Call0 win32.tgz , IH&
WA RN IREL, 2w %A 13 = FF /8 Target->Optmization->Enable long callsi 1 .

6.2 Mapf&i

fEmemmap.xmm AR T RCE,  HH AR R IAIA K di € S 22 BUN TS 2% Maplic & (5 2

ﬂ*ﬁ:
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BEGIN srom

0x60000000: sysrom : srom : 0x800000 : executable ;

sromO : C : 0x607C0000 - Ox607fffff : .srom.info.rodata .srom.rodata
.srom.literal .srom.text .rom.store;

END srom

R ZBANATPURCE HiEB, W0 .1iteral .text .rodata .

6.3 [T

Gl fE, FT AL I 7 A8 FwConfigXIP.xmlfC & S04, A 7 X F
generate dsp fw.bat RK2108 FwConfigXIP.xml

I FT G 2 A LOGHE B él A2 3 AXIPAL, WS TUHAS 715 R ZE FwConfig XIP.xmlHEXT B [ ik
3 [ 5 Map H Hiu ki 35 2 75— 2

e A LR H S S AFAEFwConfigXIPxmI SO, v DA [ 4] 00 - fEFwConfig.xmI SCAFFE Al |
EHATSINEXTE R A .

6.4 [& e

[E4 3T 8 J5 5 2 A flirkdsp fw.cfllext rkdsp.binPA N0, HAdirkdsp fw.c U 51 AE8
ext_rkdsp.bin 3CAF HH5E R 2 Flashfg B B . LAMaplZ 0 b A E],  somOf L4k kit
0x607C0000, 5SROM;E 4G HHE0x600000001wF2 A10x7C0000, Flash(JH KN H0x200, K H0x7C0000 /
0x200 = 0x3E00. %&33% [ {1 i M Hfext_rkdsp.binkesk 2 0x3E004 & .

7. JBAZ Y

7.1 85 P B

MCU #1 DSP il i Mailbox #4715, Mailbox {15 4 /MiliE, — /MBI L% 32bit ff) CMD 1 Data %
o BROKIEHE, CMD IBIEEH a0, RaX ki BT E; Data BIEEHEE, —&KA
work B{# config [f] buffer #84%t. 294 T7E drv_dsp.h #1, DSP_CMD WORK. DSP_ CMD READY.
DSP_CMD_CONFIG %%,

1 DSP i35, DSP &HHT H S MVIMGILEEE . VIt 5Em)5, DSP 2Kk i% DSP_CMD_READY i
4, MCU stz 35, 2 “rk_dsp_config” ek 06t DSP #EAT trace 5 AHC(E B HIACE . DSP #24F|
DSP_CMD_CONFIG Jf HEC B 5¢ )5, 4 4&i% DSP_CMD_CONFIG DONE, #/REECL5emk, ALl
ITHEVETAE . XREUTEERIEA N T—MEF IR, BF 55w T U7 5E A .
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7.2 Cacheiii BH

EMCU 5DSP#HTHHE R H A A, BT X5 Cacheiar. (FEDSP L }16k icache 16k deache) , A
FE(ECache—EUPEn) @, BIXUT )3 — il vp 5 NI, 2 %efECache 5N, FEHELEXMETT (WiCache
P, 230 A write back B Cache SR B& Jywrite through®$) A 2 SLhrfENAET S, XK ST HRBU
JrEAERE, ATREIREIAN R B . DRI, Dok SR DG I R, E i U I XA H invalidate
writeback M5 1, #FEEOWR:

// RK2108:

rt_hw_cpu_dcache ops(RT_HW CACHE FLUSH | RT HW CACHE INVALIDATE, (void *)addr,
size);

rt_hw cpu dcache ops(RT_HW CACHE FLUSH, (void *)addr, size);

rt hw cpu dcache ops (RT_HW CACHE INVALIDATE, (void *)addr, size);

// RK2206:

rk dcache ops (RK _HW CACHE CLEAN | RK HW CACHE INVALIDATE, (void *)addr, size);
rk _dcache ops (RK_HW CACHE CLEAN, (void *)addr, size);

rk dcache ops(RK _HW CACHE INVALIDATE, (void *)addr, size);

// HIFI3 DSP:

xthal dcache region writeback inv((void *)addr, size);

xthal dcache region writeback((void *)addr, size);

xthal dcache region invalidate((void *)addr, size);

TEMCUKR IR B4 DSPHT, 8% EHMCU%) H FIDSPHbuffer, MCUR % Z A8 FHwritebackd% 1, DSPif &
3 0d Finvalidated: 1, HIDSP#H FIMCUbuffer, MCUEZE 35 4d Finvalidateds 1 2 . ZEDSPAbH 58 & 3%
HELEMCURT, DSPHH Hibuffer s 2% FHwriteback$ 1. ARK2108F &8 11441, mEIM0T:

char *buf to dsp; // write by MCU, read by DSP
int buf len to dsp;
char *buf to mcu; // write by DSP, read by MCU

int buf len to mcu;

/* MCU side start */

rt_hw cpu dcache ops (RT HW CACHE FLUSH, buf to dsp, buf len to dsp):;

rt hw cpu dcache ops(RT HW CACHE INVALIDATE, buf to mcu, buf len to mcu);
rt_device control (dsp_dev, RKDSP_CTL QUEUE WORK, work); // Send message to DSP
/* MCU side end */

/* DSP side start */

xthal dcache region invalidate(buf to dsp, buf len to dsp);
/* processing */

xthal dcache region writeback(buf to mcu, buf len to mcu);
/* DSP side end */

/* MCU side start */

rt_device control (dsp_dev, RKDSP CTL DEQUEUE WORK, work); // Wait message from
DSP

/* MCU side end */
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7.3 7 J8 Cache

ITCM. DTCM. SRAM/¥Cacheili ¥ NITEIRAS, XIP. PSRAMZ bl 4% [A] () Cache Al G895 HLIRAS, A
DI DL 2 0 JF )3 Cache:

// XCHAL CA WRITEBACK{U A H—FhHing, HAhZHE nIBkEs ¢ XAAEE
xthal set region attribute((void *)addr base, size, XCHAL CA WRITEBACK, O0);

VER, JFJACacheFAA—EXTIEREAIRTF, IEHHR T Cachefir 13, HanHERBUE, T HETF)H Cache 53
PERE N FE, PRbEN s A SLhriksE. BHRIDSPFE & WA Cachefr H RS T, WSS EARID
TFEIHT
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1. SZFR H b5 Himenuconfigh RT_DSPFW_FILE NAMEf§E. €

2. @IUMCUYE R B AT Finvalidatei2 11, FAMCUNZLFEHEE, SN HiE 1 Buffer, T REE A HAD LR i F I T #2 7E Cacherlt, I BRAER N
“E g, EAEDSPHAT S EIER(E, MCUSiCache i B i 4, WIRESEUMEHE S ], WIS R IEREHE . o
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